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1 Introduction
Space Control is an interactive, real-time application for multitrack sound spatialization.
Based on a concept by and designed in consultation with João Pedro Oliveira, it was
developed between 2020 and 2022 by Raphael Radna. Space Control is implemented as a
Max/MSP standalone application for Mac and Windows computers, and makes extensive
use of custom Javascript extensions and external objects written in C++. Key features
include:

• spatialization using up to 128 sources and between 4 and 24 output channels;

• intuitive, easily learned graphical user interface;

• real-time playback, metering, and editing;

• offline (faster than realtime) export in multi-mono or interleaved formats;

• virtual mixer for balancing sources in the spatial mix;

• per-source volume automation;

• waveform zoom functionality enabling spatialization on the microsound timescale;

• algorithmic transformations of spatial trajectories;

• bass management option with adjustable subwoofer level and crossover frequency;

• scalable interface with 4 magnification levels;

• and the ability to save and load user project files.

Space Control simplifies the process of composing spatial music, encouraging a focus
on creative rather than technical concerns. The user defines the spatiotemporal movement
of each source using two correlated graphical interface modules: a timeline superimposed
on the source waveform, for setting points in time; and a circular representation of the 2D
spatial field, for assigning corresponding spatial positions. The spatial trajectory appears
as a chain of points, each synchronized with a time in the input file, that can be edited
either directly or programmatically.

During playback, a source travels along this path, reaching each subsequent point at
its specified time, with the intermediary positions attained through linear interpolation.
Adjustments are facilitated by real-time monitoring and editing, and a mixer that allows
changes to be made to the relative balance of the sources, among other features.

A multichannel mix can then be exported, which accounts for the movement, amplitude
envelope, and mix parameters of each source; and with channels corresponding to speaker
locations in the user-defined loudspeaker layout. Common layouts are easily selected from
a collection of presets, with custom configurations also supported. Mixes can contain
between 4 and 24 output channels.
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1.1 Spatialization Method

Space Control implements Amplitude Panning between Stereo Pairs (“APbSP”), a spatial-
ization algorithm originally used in spatium.panning, part of the Spatium spatialization
tools created by Rui Penha.1

In APbSP, each source is distributed to between 1 and 4 speakers, depending on its
location. First, the angular direction (azimuth) of the source is used to determine its
balance between the 2 speakers nearest to it via equal-power panning. The distance from
the source to the center of the spatial field (radius) is then used as the parameter of a
second equal-power panning between this pair of speakers, and those nearest the position
reflected across the radius perpendicular to the source.

1.2 Installation Notes

1.2.1 Mac

Space Control is compatible with macOS 10.11.6 or later.
Installation is straightforward: simply double click the .dmg disk image file to mount

it, then drag its contents from the window that appears to a directory on your local drive
(typically Macintosh HD Applications Space Control). Following this, the .dmg may
be deleted.

The first time an attempt is made to run Space Control, the system may display a
message stating that it “cannot be opened because the developer cannot be verified:”

1R. Penha and J. Oliveira, “Spatium, tools for sound spatialization,” in Proceedings of the Sound and
Music Computing Conference 2013, Stockholm, Sweden, 2013, pp. 660–667.
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In this case, select Cancel and then open the System Preferences. Navigate to the “General”
tab of the “Security & Privacy” pane, and press the Open Anyway button near the lower-right
corner of the window:

Upon the next attempt to launch Space Control, the system will display a similar message,
but with the option to run the application. Select Open and Space Control will start up:
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On some systems, a slightly different message may be displayed, and the Open Anyway

button may not appear in the System Preferences:

In this case, the “quarantine” attribute must be removed from the application executable.
This is done by issuing the following command in the Terminal:

xattr -dr com.apple.quarantine /path/to/Space\ Control.app
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1.2.2 Windows

The Windows version of Space Control is built and tested on Windows 10 (64-bit).
To install, simply extract the contents of the .zip file to a directory of your choice. To

run Space Control, double click Space Control.exe.

1.3 Note to Windows Users

As of version 1.0.1, Space Control is available for Windows computers. While this manual
primarily addresses the Mac version of the software, program operation and functionality
are virtually identical. Differences will be found mainly in the keyboard shortcuts: where

is shown, Windows users should substitute ctrl . It was necessary to make some more
substantial modifications to keyboard shortcuts; such changes are given in footnotes.

There are also minor discrepancies in the application menus, resulting from differences
between the two platforms. Windows users can access the Preferences window from
Window Preferences .

1.4 Version History

1.0.1

• Initial Windows release.

• Added ability to quit by closing the main application window.

1.0.0

• Initial public release (Mac only).
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2 Quick Start

2.1 Video

Click here to watch the Space Control Quick Start Video on YouTube.

2.2 Guide

Follow these instructions to start using Space Control immediately:

1. Load an audio file (.wav or .aiff) by clicking the open button on channel strip 1
(outlined in red), or via drag-and-drop onto the Timeline module (outlined in blue):

2. Click and drag in the lane above the waveform timeline (outlined in red) to create
time points for spatialization and synchronize them with the loaded audio file:

Use the zoom slider (outlined in blue) and the waveform navigator (outlined in
green) to focus on a section of the waveform and work at smaller time scales. See
section 3.1 for more about the Timeline module.
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3. Click and drag the points that appear in the Space module (outlined in red) to set
corresponding spatial coordinates for the time points created in the previous step:

4. Press Space to play the entire mix from the beginning, + Space

to play just the section shown in the waveform timeline, and + L to enable or
disable looping.

5. To spatialize additional sources, select another track by clicking the numbered
button at the top of its channel strip, then repeat the foregoing steps.

6. Press + E to export the multichannel mix.
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3 Interfaces
This section describes the interface modules that make up Space Control’s main window,
as well as the Event List, Breakout, and Preference windows. The main window is divided
into 3 modules that together provide the primary spatialization functionality:

1. the Timeline module, for defining time points relative to an audio source;

2. the Space module, for assigning spatial locations to the time points;

3. and the Mixer module, for adjusting the balance between multiple sources.

The Space Control main application window, consisting of the Timeline (1), Space (2), and Mixer
(3) interface modules, as it appears when the program is first opened.

The Event List, Breakout, and Preference windows provide additional means of visualizing
and refining the spatial parameters, and specifying application settings, respectively.

3.1 Timeline

The Timeline module displays the waveform of the sound file loaded on the selected track.
It consists of:

1. the waveform timeline, a variable-length waveform viewer with superimposed time
ruler, breakpoint amplitude envelope, and file name;
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2. a waveform navigator that indicates the portion of the source visible in the waveform
timeline, and allows it to be changed;

3. and the zoom slider, for adjusting the length of the section displayed in the waveform
timeline.

The Timeline module, consisting of the waveform timeline, waveform navigator, and zoom slider.

The time points for spatialization are defined using the waveform timeline (#1 in the
figure above):

• click in the lane above the waveform timeline to create new time points;

• drag a point to adjust its temporal placement;

• + click to select multiple points and move them as a group;

• and + click on a point to delete it.

There can never be fewer than 2 points, corresponding to the start and end of the sound
file. Selected points are drawn with white accents.

Additionally, an automation tool for modifying the amplitude envelope of the source
is superimposed on the waveform timeline. By default, this is a horizontal line at the
maximum level, indicating no amplitude shaping. Its range is -70dB to ±0dB and nonlinear,
with a midpoint of -12dB. Envelope points are controlled similarly to time points:

• click in the waveform timeline to create automation points;

• drag a point to adjust its level and temporal placement;

• and + click on a point to delete it.

The waveform navigator (#2 in the figure above) displays an overview of the waveform
in its entirety. The selected region is highlighted with a translucent rectangle. Clicking or
dragging in the waveform navigator changes the start position of the selected region: the
section shown in the waveform timeline. During playback, position indicators are drawn
in both the waveform timeline and waveform navigator.

The narrow vertical slider (#3 in the figure above) controls the waveform zoom level.
When the slider is at the bottom of its range, the entirety of the waveform is visible in
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the display. As it is moved upwards, the waveform timeline zooms in, focusing on an
increasingly small section of the waveform. At the top of the slider range, the selection
becomes quite short, typically on the order of a few milliseconds. Hold to adjust the
slider in finer increments.

Audio files can be loaded via drag-and-drop onto the Timeline module. A mono file
will automatically be opened on the selected track. If an attempt is made to import a
file with 2 or more channels, Space Control prompts the user to decide if the additional
channels should also be loaded:

This message appears when an attempt is made
to load a multichannel file.

If Yes is selected, all channels in the file are loaded, beginning on the selected track and
incrementing the track for each channel. If No is selected, only the first channel of the
file is loaded. Cancel stops the file load operation.

Multiple files can be loaded at a time via drag-and-drop. In this case, the files are
loaded on the selected and following tracks, as described above, until the track limit is
reached.

3.2 Space

The Space module is a circular representation of the spatial field. It displays both the
selected source’s spatial trajectory, and the speaker layout used for playback and export.

The spatial trajectory is a chain of numbered boxes representing a sequence of positions
in space. The points are ordered according to the chronological sequence defined in the
Timeline module, and are temporally synchronized with their corresponding time points.

The methods of manipulating the spatial points are the same as those of the time
points, and in fact, the point selection is shared between the Space and Timeline modules:

• drag a point to adjust its spatial position;

• + click to select multiple points and move them as a group;

• + click on a point to delete it.
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One difference is that points cannot be added in the Space module; clicking on an
empty location instead clears the selection. Additionally, ctrl + dragging one or more
points “snaps” them to precise locations in the spatial field. Space points can snap to:

• the perimeter of the spatial field (radius = 1);

• the center of the spatial field (radius = 0);

• any of the 3 interior concentric circles (radius = 0.25, 0.5, or 0.75);

• and/or any of the 48 possible speaker positions (increments of 7.5°).

The Space module, comprising the spatial field, the spatial path of the
selected source, and the speaker layout. The points were positioned in
precise locations using ctrl .

The boxes around the perimeter of the spatial field represent possible speaker positions.
Active speakers are highlighted with the color of the selected track, and enumerated using
their corresponding output channel numbers.
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• Click on a vacant speaker position to add a speaker there;

• + click on an active speaker to remove it from the layout.

Space Control supports configurations of at least 4 and no more than 24 speakers.

3.3 Mixer

The Mixer module provides a virtual mixer for balancing the individual sources loaded
into Space Control. The number of mixer channels is equal to the number of tracks (16 by
default). The settings of the delay, mute, solo, and gain parameters affect both playback
and the exported mix.

The Mixer module. Up to 10 channels are visible at a time, with the rest
accessible via horizontal scrolling.

All channel strips offer identical functionality. Their controls are as follows:

Graphic Function Description

Select

Select the channel, loading the waveform and path of
the corresponding source in the Timeline and Space
modules. + click to open a color picker for cus-
tomizing the channel color.
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Open Open a file select dialog for loading an audio source.

Clear Initialize the channel. + click to reset the ampli-
tude envelope and spatiotemporal path only.

Keep

Retain the path in the background of the Space module
with partial transparency, as shown here. + click
to toggle for all tracks. Enabling keep for many tracks
may cause the application to slow down.

Breakout Open a dedicated Space module editor window for the
channel (see section 3.5).

Delay

Define a temporal offset in milliseconds relative to
the beginning of the mix after which the source will
start playing. + drag to adjust in finer increments.
Once clicked, values can be entered with the keyboard.

Mute Mute the source. + click to toggle for all tracks.

Solo Solo the source. + click to toggle for all tracks.

Gain
Specify the level of the source in decibels between -70
and +12dB. + drag to adjust in finer increments.
Once clicked, values can be entered with the keyboard.

Fader, Meter
The fader provides another interface for controlling
the gain parameter. The meter indicates the peak
level of the source during playback.

Below the Mixer module are two meter banks that consolidate the meters for all input
sources and output channels, respectively. The input meter bank adapts to the maximum
number of tracks, as set in the Preferences window, and the output meter adapts to the
number of active speakers. All metering is post-fader, and uses a logarithmic scale.

Additionally, the or keys decrement or increment the selected track.
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The Space module, with 3 spatial paths drawn in the background by
activating Keep in their corresponding mixer channels.

Consolidated input and
output meter banks.
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3.4 Event List

The Event List window presents the spatiotemporal path data of the selected track in an
editable tabular format. The columns in the table are as follows:

• “Point” identifies the points by numerical index, and cannot be changed.

• “Time” is a normalized value from [0, 1], corresponding to the position of the point
in the Timeline module, where 0 is the start of the audio source and 1 is its end.
The time range of each point is bound by the time values of its neighbors. The
endpoints have fixed values of 0 and 1.

• “Azimuth” refers to the direction of the source, and is specified as an angle in degrees
on the range [-180, 180] where 0 is the front of the spatial field.

• “Radius” is a distance on the range [0, 1]. A value of 0 places a point at the center
of the spatial field, and a value of 1 places it on the perimeter.

The Event List window.

The time, azimuth, and radius values can be changed by clicking + dragging vertically
with the mouse. Additionally, once one of these fields has been clicked, a value can be
entered with the keyboard. Changes made in the Event List window are immediately
visible in the Timeline or Space modules, and vice versa.

The Event List window can be accessed from Window Open/Close Event List , or with
+ 2 .
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3.5 Breakout

Each channel in Space Control has a dedicated, miniature Space module called a Breakout
window. The Breakout window for a particular source is opened by activating the Breakout

button on its corresponding channel strip. Interacting with a Breakout window is largely
the same as interacting with the Space module, with the following exceptions:

• selected points are only highlighted in the primary channel’s Breakout window,
though group selection and adjustment are still possible in all Breakouts;

• only changes made in the Breakout window of the primary channel are registered in
the undo history;

• position indicators are not displayed in the Breakout windows during playback;

• the speakers are not displayed, and no changes can be made to the speaker layout,
though the radial reference lines corresponding to active speaker positions are visible.

A Breakout window.

The Breakout windows can be set to 1 of 3 sizes in the Preferences window. Additionally,
the Breakout windows for all tracks can be opened in a grid formation from Window

Open/Close Breakouts , or with + 3 .

3.6 Preferences

The Preferences window is accessed from Space Control Preferences . It presents global
options related to the operation of Space Control organized across 4 pages: General,
Audio, Bass Management, and Output Assignments.
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The options on the General page are as follows:

Name Range Description

Application Zoom 1x, 1.25x, 1.5x,
2x

A factor by which the entire Space Control
interface will be magnified.

Breakout Size small, medium,
large

The relative size of the Breakout windows.

Number of Tracks [1, 128] The maximum number of sources in the pro-
gram session. Using a greater number of
tracks increases the CPU load.

Export Mode multi-mono,
interleaved

The format of the export mix: either multi-
mono (n mono .wav files, one per output
channel) or interleaved (a single multichannel
.wav file with n channels).

Export Bit Depth 16, 24 The bit depth of the exported audio file(s).
Output Gain [-70dB, +12dB] A master gain control for the entire mix.

The General page of the Preferences window.
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The options on the Audio page are as follows:

Name Description

Driver The audio driver used by Space Control.
Output Device The interface used for audio output.
Sampling Rate The sampling rate used by Space Control. The options are

hardware-dependent. Any source files with a differing sampling
rate will play back at a different speed.

Buffer Size The number of samples processed during one calculation of the
DSP chain. The options are hardware-dependent. Selecting a
lower buffer size causes source positions to be calculated more
frequently during playback, increasing the CPU load.

The Audio page of the Preferences window.
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The options on the Bass Management page are as follows:

Name Range Description

Use Sub Off, On When on, each source is processed through a
4th-order Linkwitz-Riley crossover filter. The
high-pass band is spatialized as usual, while
the low-pass band is routed to a dedicated
low frequency (subwoofer) channel, which is
monitored and exported separately. Using
bass management increases the CPU load.

Crossover Fre-
quency

40, 60, 80, 100,
120

The crossover frequency in Hz.

Sub Channel – Assign the subwoofer channel to an output
of the selected audio interface.

Sub Gain [-70dB, +12dB] A gain control for the subwoofer channel.

The Bass Management page of the Preferences window.
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If the Bass Management option is active, the peak level of the subwoofer channel appears
in the output meter bank. It is distinguished by its orange color.

Output meter bank for
a 5.1 surround layout
with subwoofer channel
enabled.

The Output Assignments page provides a matrix for assigning the 24 logical outputs of
Space Control (corresponding to the active speaker numbers in the Space module) to the
outputs of the audio interface selected on the Audio page. Assignments can be repeated,
so it is possible to map a greater number of logical channels to a lesser number of outputs.

The Output Assignments page of the Preferences window, displaying the
routings used in Studio Varèse at UCSB.
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4 Menus and Actions

4.1 Menus

This section lists the items in each of the application-specific Space Control menus, gives
their keyboard shortcuts (if applicable), and describes their functions.

The Space Control menu bar.

4.1.1 Space Control

The Space Control menu provides access to the About and Preferences windows.

Item Name Shortcut Description

About Space Control – Display a window containing information about
Space Control. Click anywhere or press any key
to dismiss the window.

Preferences – Open the Preferences window.

4.1.2 File

The File menu primarily offers functionality related to saving, loading, and initializing
the program session.

Item Name Shortcut Description

New + N Display a dialog box prompting the user to ini-
tialize the session. Any unsaved work will be lost
if the session is initialized.

Open + O Open a file select dialog for loading a session file.
Close + W Close the front window. Disabled for the main

window.
Save + S Open a file save dialog for saving the current

session to disk. Once a file has been saved or
loaded, subsequent Save operations will reference
this file.

Save As + + S Open a file save dialog for saving the current
session to disk under a new file name.
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4.1.3 Edit

The Edit menu allows some standard processes to be applied to the selected spatiotemporal
point(s).

Item Name Shortcut Description

Undo + Z Undo the last change made in the Timeline or
Space modules. Selecting a track clears the undo
history.

Redo + + Z Redo the last change made in the Timeline or
Space modules.

Cut + X Copy the selected point(s) to the clipboard, then
delete them. If the operation would leave fewer
than 2 points, the selection is copied but not
deleted.

Copy + C Copy the selected point(s) to the clipboard.
Paste + V Paste point(s) from the clipboard into the spa-

tiotemporal path of the selected track, merging
with the existing points.

Paste Replace + + V Paste point(s) from the clipboard into the spa-
tiotemporal path of the selected track, replacing
the existing points. The clipboard must contain at
least 2 points in order to complete the operation.

Delete Delete the selected point(s). The operation is not
completed if it would leave fewer than 2 points.

Select All + A Select all the spatiotemporal points of the selected
track.

4.1.4 Audio

The Audio menu provides access to certain functions for controlling the mixer and playback.

Item Name Shortcut Description

Play Mix Space Start playback of the entire mix from the begin-
ning, or stop playback.

Play Selection +

Space
Start playback of the selected section of the mix,
or stop playback. All tracks are synchronized to
the selection, accounting for any temporal offsets
defined using channel Delay parameters.
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Play from Selection + +

Space 2
Start playback from the selected section of the
mix, or stop playback. Playback continues beyond
the end of the selection until the end of the mix.

Loop + L Enable or disable looping the mix or selection
during playback.

Export Mix + E Open a file select dialog for exporting the current
session as either one or several audio files (depend-
ing on the Export Mode setting), then initiate an
offline render and save the mix to disk. The time
required to complete the operation is a product
of the number of tracks used, the durations of the
sources, and number of speakers/output channels.

4.1.5 Transform

The Transform menu enables algorithmic transformations of the selected spatial point(s).
Transformations requiring variable parameters summon a dialog box prompting the user
for input. Parameters of an invalid form are set to 0. Successful transformations register
in the undo history.

Item Name Shortcut Description

Repeat Last Transform + R Repeat the last transform using the same param-
eters (if applicable). This item is disabled until
the first time a Transform menu item is invoked.

Translate – Translate the selection using 2 values representing
Cartesian offsets in the X and Y dimensions.

Rotate – Rotate the selection by an angle in degrees.
Scale – Scale a selection relative to its center by a scaling

factor. Values between 0 and 1 contract the se-
lection, and values greater than 1 expand it. The
operation has no effect on a single-point selection.

Invert X – Reflect the selection across the X axis.
Invert Y – Reflect the selection across the Y axis.
Retrograde – Reverse the order of the selected spatial points.

The operation has no effect on a single-point se-
lection.

Randomize – Randomize the position of the selection using 2
values representing bipolar Cartesian offset max-
ima in the X and Y dimensions.

2For technical reasons, the Play from Selection shortcut is ctrl + Space on Windows.
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The parameter entry prompt for the Rotate trans-
formation.

4.1.6 Layout

The Layout menu offers several common speaker layouts as presets, and some simple
means of transforming the active speaker positions.

Item Name Shortcut Description

4ch1 – A quadraphonic layout with a pair of speakers at
the front of the spatial field.

4ch2 – A quadraphonic layout with a single speaker at
the front of the spatial field.

5.1 – A typical 5-channel surround layout.
7.1 – A typical 7-channel surround layout.
8ch1 – An octophonic layout with a pair of speakers at

the front of the spatial field.
8ch2 – An octophonic layout with a single speaker at the

front of the spatial field.
16ch – A layout with 16 speakers placed equidistantly

around the spatial field.
Rotate – Rotate the active speakers by an angle in degrees.

Any value entered will be rounded to the nearest
multiple of 7.5°.

Renumber – Renumber the active speakers according to a new
order entered by the user.
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4.1.7 Window

The Window menu provides access to certain of Space Control’s auxiliary windows.

Item Name Shortcut Description

Open/Close Event List + 2 Open or close the Event List window.
Open/Close Breakouts + 3 Open or close all Breakout windows. The windows

open in a grid formation by default.

Breakout windows in a grid formation.

4.1.8 Help

The Help menu provides a search bar for locating and invoking items in any of the other
menus.

4.2 Actions

This section summarizes the actions available for interacting with certain components in
the main window. This information, largely repeated elsewhere in the manual, is compiled
here for ease of reference.

4.2.1 Timeline

The lane above the waveform timeline:

Action Description

Click Create or select a time point.
Drag Adjust the temporal position of the selected time point(s).

+ Click Select multiple time points, or remove them from the selection.
+ Click Delete a time point.
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The waveform timeline:

Action Description

Click Create an automation point.
Drag Adjust the level and temporal position of an automation point.

+ Click Delete an automation point.

The waveform navigator:

Action Description

Click , Drag Set the start of the waveform selection.

The waveform zoom slider:

Action Description

Drag Change the length of the waveform selection.
+ Drag Adjust the slider in finer increments.

ctrl + Z 3 Return the slider to the minimum level.

4.2.2 Space

The spatialization area:

Action Description

Click Select a space point.
Drag Adjust the spatial position of the selected space point(s).

+ Click Select multiple space points, or remove them from the selection.
+ Click Delete a space point.

The speaker locations:

Action Description

Click Add a speaker at that location.
+ Click Remove the speaker at that location.

3This shortcut is + ctrl + Z on Windows, to avoid conflict with the Edit Undo shortcut.
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4.2.3 Mixer

The Select button:

Action Description

Click Select the track.
+ Click Select the track and open a color picker for customizing the

channel color.

The Clear button:

Action Description

Click Initialize the channel.
+ Click Initialize the channel spatiotemporal path and amplitude enve-

lope without removing the audio source.

The Keep , Mute , and Solo buttons:

Action Description

Click Toggle the setting for the channel.
+ Click Toggle the setting for all channels.

The Gain and Delay number boxes:

Action Description

Click Focus on the parameter, enabling keyboard input.
Drag Adjust the parameter for the channel.

+ Drag Adjust the parameter for the channel in finer increments.
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5 Tips
This section compiles some details, insights, and suggestions about using Space Control
that may not be immediately obvious.

• If a path contains more than 2 points, a timeline endpoint can be deleted; the
nearest point becomes the new endpoint.

• To specify a stationary source, use a path consisting of 2 points located in the same
position in the spatial field.

• If consecutive points are located at the center of the spatial field (i.e., radius = 0),
but have different azimuths, the source will rotate between them. Custom azimuth
values are most directly specified in the Event List window.

• To create a mix with fewer than 4 channels, use a quadraphonic layout and either
discard the extra channels, or mix them into fewer channels.

• The path of one channel of a stereo audio source can be duplicated and inverted
across the Y axis to yield a symmetrical path for the other channel.

• The operations in the Transform menu need not be applied to an entire path.
Interesting results can be obtained by, for example, performing a Retrograde on
only a few points.

• The Transform menu operations as a whole provide means of creating subtle varia-
tions of a spatial path. Applying slightly different paths to slightly delayed copies
of the same source can enhance the perceived density of the spatial image, a phe-
nomenon known as decorrelation.

• The same spatialization algorithm is used for both playback and export, but with
one key difference: while the export operation calculates the source position for
each sample, this is only calculated once per sample buffer during playback. This
optimization results in a degree of amplitude smoothing that is dependent on the
buffer size. If discontinuities (clicks, pops, etc.) occur during playback, try increasing
the buffer size.

• The session files saved and loaded by Space Control are stored in a human-readable
JSON format. As long as the syntax of the file and the ranges of certain parameters
are respected, the data can be modified in a text editor, or even generated by a
script. But be warned: invalid formatting or data will result in undefined errors!
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7 Disclaimer
The Space Control software and its documentation are provided “as is” and without any
warranty of any kind, either express or implied, including liability or warranties relating
to fitness for a particular purpose, or infringement of any patent, copyright, or other
intellectual property right.

In no event shall the authors be held liable for any direct, indirect, special, incidental, or
consequential damages, or any damages of any kind, resulting from the use of the software
or its documentation. The authors make no warranty or representation, expressed, implied,
or statutory, with respect to the software or the contents or use of this documentation,
and specifically disclaim its quality, performance, or fitness for any particular purpose.

Use of the software and its documentation is at the sole discretion of the user, who
assumes all risk, and agrees to be solely responsible for any damages resulting from such
activities, including but not limited to data loss, loss of profit, or damage to their computer
system. No information or advice received from the authors shall create any warranty
for the software. The authors disclaim responsibility for any errors or omissions in the
software or its documentation, and for any damages resulting from their use.
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